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Chapter 1

AmigaTable

1.1 AmigaTable v1.2 AmigaGuide
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* AMIGA TABLE v1.2 *
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Fully-Featured Table-Making
Program - make/modify slick-
-looking and versatile tables
and save as IFFs for use in
almost ANY Amiga WP/Graphics
package. (also includes macro
to import tables directly to
FinalWriter WP)
CONTENTS

OverView

Requirements

Installation

Using From FW

Making A Table
Saving/Loading
TroubleShooting

Current Bugs

Contacting Me

Registering

UNREGISTERED - FULL VERSION COSTS ONLY £4.00

CLICK HERE TO FIND OUT HOW TO REGISTER
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1.2 OverView

This is a restricted, unregistered shareware version of AmigaTable (v1.2)

Run this program from WorkBench or call it using the supplied macro from FinalWriter to create or

edit tables, then your tables can be saved as IFFs or automatically inserted into a FinalWriter Document.
Please distribute this SHAREWARE version of the program EVERYWHERE - to BBSes, magazines, etc - it’s
free, and here to be enjoyed and used.

If you decide to register for the full program, which costs only £4.00, please send a cheque for this

amount, payable to C.Partridge, to the usual address

1.3 Requirements For Use Of AmigaTable

To use AmigaTable on your computer, you will need:

- An Amiga with KickStart 2.0x +

and that’s it!

If you also have FinalWriter wordprocessor, you can use the supplied macro to create

tables from the package and import them directly into the program. A Hard Drive is also recommended, but
not essential.

How To Install AmigaTable.

1.4 Installation

[
| To Install AmigaTable On Your Hard Drive: |
[

- Copy the file AmigaTable onto your hard drive also.

- Copy contents of the LIBS directory into your own main LIBS directory
(i.e: COPY LIBS/A#? SYS:LIBS)

- Copy the file AmigaTable.Prefs into your own S: directory

(i.e: COPY S/AmigaTable.PREFS SYS:S)

- Make the assign AmigaTable: to the directory where you have

put the file ’AmigaTable’, i.e: put this line in your

user-startup file:

ASSIGN AmigaTable: <dir where AmigaTable is>

And that, as they say, is that, unless...

..IF YOU WISH TO USE THE SUPPLIED MACRO TO CREATE/IMPORT TABLES TO AND FROM FINALWRITER:-

- Copy the file AmigaTable.Rexx wherever you wish to on

your hard drive. (normally in FWMacros directory)

AmigaTable is run from WorkBench, by double-clicking on its icon, but in the case of owners
of FinalWriter wordprocessor, can be run directly from inside FinalWriter

Making A Table
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1.5 Running the Arexx Script using FinalWriter

There are three ways to run the script AmigaTable.rexx from inside FinalWriter:

1) Select the PREFERENCES option in the VIEW menu at the top of the screen.
Click on the clicktab at the top of the window that reads "Buttons".

From the list of blank buttons on the left of the window, drag a button into

the middle part of the window, where the current button strip is displayed.

(Select a new button strip first if you wish)

Next, change the cycle gadget on the right to read "Run Arexx Script", click on
"Select" and locate the file AmigaTable.rexx that you copied to your hard drive
during installation.

Click on "OK" and the arexx script can now be run by clicking on your new button.
2) Select the PREFERENCES option in the USER menu at the top of the screen.
From here, click on "New" to define a new option. Change the cycle gadget to

read Arexx Script. Click on the "Select" button and locate the file AmigaTable.rexx
that you have copied to your hard drive.

Define a hot key for the menu option if you wish, using the buttons on the bottom left
of the window. Also, type in a name for the option, such as "Final Table", in the appropriate
gadget.

Finally, click on "Accept". You can now run the arexx script by selecting your new
menu option, or pressing its shortcut key. (if you defined one)

3) Each time you wish to run the arexx script, select RUN AREXX SCRIPT from the USER menu
at the top of the screen. Locate the script AmigaTable.rexx which you copied to your
hard drive when installing AmigaTable. Press OK and the program will run.

Please see your FinalWriter manual for further details.

See: Importing Tables from FinalWriter

Click on retrace above to return to the previous page.

1.6 Using The Program With FinalWriter

[
| HOW TO CREATE A TABLE FROM FINALWRITER |
[

Load FinalWriter in the usual way.
If you wish to type in your table in FinalWriter, and then edit it
in AmigaTable, use the first method below. If you wish to load an old

table or create a new one, follow the second method:
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So:
EITHER:

1) Type in the text you wish to make into a table, separating
each item with commas, e.g:

Name,Price,Comment

BMW,£300,Wow!

Ford,£200,Great

Granada,£500,Rip Off

If you wish to use commas in your table itself, you must change
the Default Separating Character in the preferences

screen.

Type in your text in PLAIN writing. Do not use BOLD, ITALICS,
or any other different typestyles - these can all be put in

the table later.

Do not change Font, FontSize, Style or ANYTHING whilst you
are entering the text that is to become your table.

Now highlight the text using the left mouse button.

OR:

2) Don’t highlight any text at all
THEN:-

You need to run the Arexx Script ’AmigaTable.rexx’
(from wherever you put it when you installed AmigaTable!)
After a brief pause, a window will appear.

IMPORTANT:

If you highlighted text, your table will shortly appear in this window.

If you highlighted no text in FinalWriter, then a blank 1 by 1 table will appear.

You can then either open an old table (using the "Open" option of the "Project” menu)
or click or create a new table.

You have now entered the main table editing window

1.7 Main Editing Window

[
| HOW TO MAKE/MODIFY A TABLE |
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When you load AmigaTable, a blank one-by-one table is displayed in the window. (unless
you are calling the program from FinalWriter in conjuction with the supplied macro) Extra rows/
columns can be inserted using either the menus or by changing the number displayed in the "Rows"
or "Cols" gadgets. (for more information about this, see the button below)

Move around the table using the cursor keys, or click on a cell with the mouse.

The four buttons on the left decide whether a single cell/group of cells is

selected:

Row = Current row

Coll = Current column

All = Entire table

Single = Currently selected cell.

To switch between these, either click on the buttons, use the *Affect’” menu

options, or press the keys, R C A and S. (on their own)

IMPORTANT!

soskeoskeoske sk skoskoskoskok

Those options marked here with an * asterisk * may be disabled or limited in

this unregistered version:

Changing the contents of a cell

* Changing the typestyle / colour

* Changing the justification

Changing the font

* Inserting/Removing Columns / Rows

Changing Column / Row widths

Changine Fonts / Sizes , etc..

* The Preferences Screen

Before exiting: Saving/Loading Tables

When you’re done: Generating your table

1.8 Saving/Loading

Saving Your Table

Before leaving the program, it may be a good idea to save it for future editing.
You can do this using the "Save" option of the project menu, or pressing Right Amiga and S.
Modifying Your Table At A Later Date

Load AmigaTable. (If called from FinalWriter, do not highlight any text before
executing the macro)

Choose the option "Open" from the "Project” menu.

Choose the name of your saved table using the file requester which appears.

Your table will then load and can be edited in the usual way.
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1.9 Editing the contents of a cell

Editing the Contents Of A Cell

This can only be done if a SINGLE CELL is selected (Click on the ’Single’ button
at the left of the window)

The contents of the cell are displayed at the top of the screen, in the ’Cell’

gadget.

EITHER: Click in this gadget, edit the contents and press RETURN

OR: Select the Edit Text option from the menus.

OR: Press RIGHT AMIGA and E, edit the contents and press RETURN

- this last keyboard shortcut makes life easier when creating new tables and entering

lots of text.

1.10 Inserting/Removing Columns and Rows

TO INSERT/REMOVE ONE COLUMN OR ROW

Move to the place where you wish to insert/remove a column/row
Select the menu option "Edit/Insert Row" or "Edit/Remove Row", etc... or press the
appropriate shortcut key (shown on the menu bar itself)

TO INSERT/REMOVE MULTIPLE COLUMNS/ROWS

Click in the Rows/Cols gadget at the top of the screen and type in the new number of
rows or columns required.

The table is then adjusted automatically. In some cases, this takes a few seconds.

1.11 The Preferences Screen

The Preferences Screen

Click on "Preferences" to come here.

From here, you can change:

Title: If selected, the title is displayed on the table.

Separator: This is only for those using the supplied macro to import tables into Final
Writer and defines the character separating columns when you type your text

into FinalWriter: i.e: usually a comma.

GridLines: You can turn on/off the horizontal or vertical gridlines

Border: You can choose to have a thick, normal or no border.
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Justify: You can choose the default justification of cells when the program is started.

Fonts: You can choose the default font that cells/title use when the program is first

started.

Click on "USE" to use these settings, or "CANCEL" to revert to the previous settings.

As this is an unregistered version, settings cannot be saved and thus some of these preferences
options are of no use in this version. Please register for only £4.00 to get the full version.

(Press "Retrace’ above to return to previous page)

1.12 The Affect Buttons / Menu

THE AFFECT MENU / AFFECT BUTTONS

The four buttons on the left decide whether a single cell/group of cells is selected.
Row = Current row

Coll = Current column

All = Entire table

Single = Currently selected cell.

To switch between these, either click on the buttons, use the *Affect’” menu
options, or press the keys, R C A and S. (on their own)

(Press ’Retrace’ above to return to previous page)

1.13 TypeStyle

Changing the TypeStyle/Colour of cell/cells:

To change the type style of a cell/group of cells (depending upon the
affect buttons ) either use the *Edit’ menu, or

press the appropriate shortcut keys:

RIGHT AMIGA + P : Plain Text

RIGHT AMIGA + B : Bold Text

RIGHT AMIGA + 1 : Ttalic Text

RIGHT AMIGA + U : Underlined Text

To change the colour of a cell/group of cells, select a new colour from
the colour menu, or press RIGHT AMIGA and a number from 1-8.

Other changes
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1.14 Column / Row size

Changing the Column / Row Sizes:

Press RETURN on a cell to alter the column/row width of the current column or row.
Two lines will appear, showing the width of the column and the row Alter these
using the cursor keys also: Press up/down to change the row height, or left/right

to change the column width.

Then press RETURN to confirm the change.

{"Other Changes" link mainwin }

1.15 Justification Of Cells

Changing the Justification Of Cells:

To change the justification of the selected cell(s) either use the Justification” menu, or
press the appropriate shortcut keys:

RIGHT AMIGA + L : Left Justified

RIGHT AMIGA + R : Right Justified

RIGHT AMIGA + C : Centre Justified

Other Changes

1.16 Changing Fonts, Sizes

Changing the current font of Cell/Cells

To change the font of the selected cell(s), either click in the font gadget at the top of
the screen and type in a new font, or click on the ? button and select a font from the list
To change the size of font, enter a number into the gadget at the top right of the window.

Other Changes

1.17 Generating Your Table

Press Generate to enter the preview screen, where your table is shown.

From here, choose "Save IFF" to save your table as an IFF file for use in any WP or graphics
package.

Alternatively, users of FinalWriter who have called the program via the supplied macro

may select *Use In Final-W’ from the preview screen to import the table directly into a FinalWriter
document. They then have to input the width and height of the table (in ruler units)

The rest, as they say, is history!

Good Luck!

If you have any problems, please don’t hesitate to write
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1.18 Help! It doesn’t work

"HELP! IT’S JUST NOT WORKING AND I'M VERY UNHAPPY ABOUT IT!"

OK, first, DON’T PANIC!! Bugs are always possible, so stay cool.

Firstly, simply read through all these docs. carefully.

Secondly, check:

- Have you made the assign to AmigaTable: correctly?

(If using FinalWriter:)

- Is the text that you type into FinalWriter totally plain? You should not change
font, typestyle, size or ANYTHING during the lines of text that are to become
your table.

- Have you got ARexx running in the background? (oops)

- Are you running the Arexx script properly?

- Are you totally incompetant?

Finally, look at the list of current bugs

If you still can’t work it all out, then drop me a line at the

usual address and I’ll do all I can to help.

1.19 Current bugs

- Aspect ratio of tables when displayed in FinalWriter is not correct. This can
be cured by holding down the SHIFT key and clicking on the corner

of the table (on the resizing gadget), but I hope to make it automatic

in a later release. If you are thinking *What a lame programmer, it’s

easy using Arexx with FW, then forget it - it doesn’t respond!’

- that’s all I can find at the moment. Feel free to drop me a line if you

find anything that I can fix - I’d be happy to hear from you!

(Click retrace to return to previous page)

1.20 The author

To contact me about ANYTHING: Registering,bugs, requests, etc...
please write to:

SceptreSoft,

c/o C.Partridge

9 Westbourne Ave

Wrea Green

Preston
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Lancs

PR4 2PL

I am also the author of:

Lock Out Professional: Multi-User HD security system, with restricted
write access, passwords, email between users

etc... (Available on Aminet, or from me)

RadBench: Ram resident workbench: like a Hard Drive

for those without one. (available from all

good PD libraries and me)

TimeZoner: Classic point and click adventure with wicked

sense of humour! (available from 17 bit PD)

If you are interested in any of these programs, please write or e-mail for
details!

Please help to keep the Amiga alive - I am very worried at the present time:
have you seen how thin some of the magazines are now getting? Tell your friends,
tell your family, tell your boss - don’t let such a great machine get beaten
into extinction - there are millions of us using it and we want it to carry on
being supported!

Cheers

1

v/

v/

CP

23/7/96

1.21 Registering

REGISTERING AMIGATABLE:

Registering the program costs only £4.00, for which you get the following:
- FULL VERSION OF AMIGATABLE - ALL FEATURES ENABLED

- TECHNICAL SUPPORT

- FREE UPGRADES

In addition, it has taken me a long LONG time to create this program (which you have for no cost)

and thus it would be very encouraging to receive any sort of donation.

I personally feel that for only £4.00, it is worth obtaining the full program, but, anyway, the

choice is yours.

If you do decide to register, please send a cheque for £4.00, made payable to C.PARTRIDGE, to:

SceptreSoft
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c/o C.Partridge

9 Westbourne Avenue

Wrea Green

Preston

Lancashire

PR4 2PL

I hope that you find the program useful!
CP

23/7/96

(Click Retrace above to return to the last page)
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